
Converting Your PDFs to Excel 
Easy 3-Step Guide 
STEP 1: OPEN YOUR PDF 

Select the ​Open...​​ ​command from the File menu. 

 

Or, click on  icon on the toolbar. 

STEP 2: SELECT PDF DATA TO CONVERT 

You must select data in your PDF prior to converting. Three 

selection options are available. 

1. Mouse Based Selection  

a. Left click mouse button​​ ​beginning at the position from 

which you want to select data.  

b. Drag the mouse pointer​​ ​(while still holding left button 

pressed!) over the content you want to select. 

2. Select Menu Options 

a. Select Page Range:​​ ​Use this to select certain pages of the 

document, e.g. Pages 1, 4, 9-12, 17. 

b. Select All Pages:​​ ​Selects all pages of the document. 

c. Select All on Page:​​ ​Selects all data on a page of the 

document. 

 

3. Command Toolbar Quick Selection 

Make quick document selections from the command toolbar: 

a.  Selects the entire document instantly. 

b.  Area: Selects only certain areas of data. 

 

STEP 3: CONVERTING TO EXCEL 

After selecting, you are ready for conversion. For conversions to 

Excel:​​ Click on  icon on the toolbar. 

Or, select “Convert to Excel” from the File menu. 

STEP 3a: CONVERSION OPTIONS TO EXCEL 

1. Automatic 

The default conversion option into Excel. Recommended for most 

conversions into Excel. Able2Extract Professional automatically 

determines the positioning of the Excel columns. 

2. Custom 

Designate how the conversion to Excel will look prior to 

conversion using the Excel Custom Conversion Panel. Click on the 

gear icon to adjust your PDF to Excel conversion settings. 

 

STEP 3b: USING THE EXCEL CUSTOM CONVERSION PANEL 

Selecting the Excel ''Custom'' conversion solution activates the 

Custom Conversion Panel on the right-hand side. This panel will 

let you manually add and reposition as many lines as required to 

designate the column breaks and rows for the conversion into 

Excel. 

1. Page Range 

Users can first designate a page range for applying and 

customizing the file’s table structure. 

a. Page Range:​​ ​Apply a table structure on each page of the 

indicated page range. 

b. Extend:​​ ​Add additional pages where they would like to 

the table structure. 

c. Exclude:​​ ​Exclude a page within a previously selected Page 

Range. 

 

 

  

 



2. ​​Named Table Structures 
You can use the ​Manage​​ ​​button to manipulate the inner table 
organization of columns that can be shared between tables of 
more than one-page range.  

a. Delete​​: Delete the named table structure. 
b. Rename​​: Change the existing name of the page structure. 

 

You can use the ​Review Tables...​​ button to manage the tables of 

the Named Table Structures you selected throughout your PDF. 

a.    ​Go To…​…​:​ Navigate to a specific table by selecting the Named 

Table Structure and then the table itself from the list. 

b.​    ​​Delete​​:​ Delete the selected table from a Named Table 

Structure. 

3. Tables 

a. Add:​​ ​Add a table to a page. 

b. Delete:​​ ​Delete a table. Once activated, left click on the table 

you wish to delete. 

c. Replot:​​ ​Automatically recalculates the column structure for 

all tables within the active page range. 

d. Find Similar:​​ Search for a specific table structure that occurs 

throughout a PDF document during a Custom Excel 

conversion. 

 

Once a table is created, you can edit the table structure using the 

tools in the conversion Panel: 

1. Columns 

a. Add Columns:​​ ​Add a column. Once activated, left click to 

add a vertical column line. 

b. Erase Column Lines:​​ ​Erase a column line. Left click on a 

column to erase it. 

c. Manage Cell Content - drop-down menu options: 

Decide how cell content is treated (such as text or 

numbers) when it comes into contact or into close 

contact with a column line. 

d. Column Types:​​ ​Decide how the content within each 

column is treated for the purposes of Excel –like 

numbers, by default, or text​. 

 

 

1. Rows 

a. Show Rows:​​ ​Show the rows on the page. 

b. Manual Row Editing:​​ ​When this option is checked, the 

“Add Rows” and “Erase Row Line” functionality is 

activated. 

i. Add Rows:​​ ​Left click to add a row​. 
ii. Erase Row Line:​​ ​Left click to erase a row. 

c. Row Settings:​​ ​Demarcate the rows based on a specific 

column table within a table or by using the existing row 

lines on the page. 

 

2. Header and Footer 

a. Edit Header:​​ ​When activated, lets you adjust the header. 

To adjust the header use your mouse and left click the 

header, hold, and move the mouse up and down. 

b. Edit Footer:​​ ​Allows you to adjust the footer​. L​eft click the 

footer line, and adjust accordingly. 

c. Header/Footer Options:​​ ​Enables the user to select to 

enable/disable the headers and footers. 

 

Click on  button and save your file to 

complete your conversion. 

Converting your PDFs to Word 
STEP 1: OPEN YOUR PDF 

Select the ​Open...​​ ​command from the File menu.  

Or, Click on  icon on the toolbar. 

 

  

 



STEP 2: SELECT PDF DATA 

You must select data in your PDF prior to converting. Three 

selection options are available. 

1. Mouse Based Selection 

a. Left click mouse button​​ ​beginning at the position from 

which you want to select text. 

b. Drag the mouse pointer​​ ​(while still holding left button 

pressed!) over the text you want to select. 

2. Select Menu Options 

a. Select Page Range:​​ ​Use this to select certain pages of the 

document - e.g. Pages 1, 4, 9-12, 18. 

b. Select All Pages:​​ ​Selects all pages of the document. 

c. Select All on Page:​​ ​Selects all data on a page of the 

document. 

 

3. Command Toolbar Quick Selection 

Make quick document selections from the Command toolbar: 

a.  Selects the entire document instantly. 

b.  Area: Selects only certain areas of text. 

STEP 3: CONVERTING TO WORD 

With PDF data selected you are now ready for conversion. For PDF 

to Word conversions: 

Click the  icon on the toolbar. Save your file to complete 

your conversion. 

Filling in PDF Forms 
Fill in PDF forms that you created or modified with Able2Extract’s 

PDF form editor. Open, complete and save PDF forms to your 

computer, or submit your data directly to servers.  

 

Editing PDF 
To Edit PDF content, click on ​Edit​​ on the command toolbar. The 

Able2Extract editing side panel will appear: 

 

Content Editing 

a. Add Text:​​ ​Add text to your page. 

b. Add Bitmap Images:​​  Add bitmap images (JPG, BMP, 

PNG, TIFF, GIF) to your page. 

c. Add Vector Shapes: ​​Add vector shapes to your page. 

d. Delete:​​ Delete PDF page objects from the PDF page. 

e. Font:​​ ​Select the font style of your text. 

f. Font size:​​ ​Specify the size of the font. 

g. Fill with Color:​​ Fill text and vector shapes with color. 

h. Outline with Color:​​ Specify the outline color of text and 

vector shapes. 

i. Line Width:​​ Adjust the line width of text and vector 

shapes. 

j. Rotate:​​ Rotate PDF page objects by 90 degrees left or 

right, or 180 degrees. 

 

  

 



Page Editing 

a. Delete:​​ ​Remove pages from your PDF. 

b. Move:​​ ​Move pages from one location in the PDF to 

another. 

c. Resize:​​ Resize your PDF page to specific sizes. The 

content on the page itself remains intact.  

d. Scale:​​ Scale your PDF pages and their content to a certain 

size. 

e. Rotate:​​ ​Rotate PDF pages by 90 degrees clockwise or 

counter-clockwise. 

f. Extract:​​ ​Extract pages from the currently opened PDF 

into a new and separate PDF file. The original source PDF 

is not modified. 

g. Insert from PDF:​​ ​Insert pages from other PDFs on your 

computer into the opened PDF. The original source PDF 

of those pages is not modified. 

h. Insert pages:​​ ​Inserts blank pages into your PDF. You can 

add PDF content directly to the pages that you insert. 

Bates Numbering 

To add custom bates numbers to your PDF, from the Edit menu 

select the command​ ​Bates Numbering →→ Add 

 

The ​Add Bates Numbering​​ dialog appears.  

 

Set the starting number and the number of digits, your prefixes 

and suffixes (Counter, Date, Page). Define additional properties 

such as a page range, font and position. 

To remove bates numbers from the PDF, from the ​Edit​​ menu 

select the command ​Bates Numbering →→ Remove​​.  

Annotating PDF 

You can annotate your PDF documents in a variety of ways. To 

start annotating your PDF content ​use​ any of the available tools: 

 

Redacting PDF Information 

You can redact PDF information directly on the PDF page, 

permanently deleting any sensitive information. 

 

Editing and creating fillable PDF forms 

To start creating and editing PDF forms, click on​   ​icon on 

the toolbar. Click on​  ​icon to switch to the​ ​Form​​ ​editing 

side panel tab: 

 

Insert the following form fields by clicking and dragging them onto 

the page: 

a. Text​​:​ Inserts a text field into the form. 

b. Combo box​​:​ Adds a combo box, and adds new items or 

deletes the existing ones. 

c. Checkbox​​:​ Inserts a checkbox into the form. 

d. List box​​:​ Adds a list box to the form. 

e. Radio button​​:​ Inserts the radio button to the existing 

group or creates a new radio button group.  

f. Action button​​:​ Resets and clears form filling fields or 

submits a new custom action. 

g. Signature button​​:​ Adds a signature placeholder form 

field to the PDF form. 

 



Designate properties for form fields such as: name, font, font size, 

text color, border and background color, line width, border style 

and dash pattern.  

Define ​read-only​​ and ​required fields​​. Click ​More​​ button to specify 

additional form properties for the selected form field.  

 

 

 

  

Adding Electronic and Digital Signatures 

You can add a signature image or a digital certificate 

(cryptographic signature) to your PDF. 

1.​ ​Open your PDF using the​ icon on the toolbar. 

2. Click on  ​icon to open the Digital Signatures side panel. 

3. Click on​ ​​Choose Signature... 

4. Choose one or both of the available options:  

 

i) Check the ​Add Signature Image​​ ​​option on to create an 

electronic signature.  

a. Click on​ ​​Create…… 

b. In the Add Signature Image dialog, ​Type, Draw or 

Import​​ your signature. 

c. Click on ​Add​​ and then on the​ Sign​​ button in the 

Signatures​​ ​​dialog. 

ii) Check the ​Digitally Sign the Document​​ option on to add a 

cryptographic signature.  

a. Select the digital certificate from the list. 

5.  Click on ​Sign​​ ​​and place the signature where you want it on the 

page. 

 

 6. Save the signed PDF by clicking on the ​Save​​ button. 

 

  

 



Brief Background 

Able2Extract Professional 14 is an all-in-one PDF suite that works 

on Windows, Mac, and Linux platforms. It can convert native and 

scanned PDFs to MS Office and other formats, create ​encrypted 

and password-protected PDF documents​, edit PDF content, 

annotate, sign PDF documents and much more. The software also 

comes with a built-in PDF viewer. 

  

System Requirements 

Operating system: 

● Windows 10/8.1/8/7, Windows Server 2019/2016/2012 

R2/2012/2008 R2, 32-bit or 64-bit edition 

● macOS 10.14 (Mojave), 10.13  (High Sierra)/10.12 

(Sierra)  

● Ubuntu 18.10/18.04/17.10, Fedora 29/28/27/26 , 64-bit 

edition 

Processor:​​ ​x86 architecture processor (32-bit and 64-bit). 

Hard Drive Space:​​ ​200 MB (Windows), 300 MB (Mac), 200 MB 

(Ubuntu), 200 MB (Fedora). 

Memory: ​​512+ MB of free memory available. 

Monitor:​​ Windows and Linux - ​1366 (Width) x 768 (Height) screen 

resolution (higher resolution screen required if OS scaling is more 

than 100%). 

Mac - ​1366 (Width) x 768 (Height) or 1280 (Width) x 800 (Height) 

non-Retina screen resolution, 2560 (Width) x 1600 (Height) Retina 

screen resolution. 

Telephone and E-mail Support 

We offer top-tier customer support. Call us at +1 416-920-2539 

(M-F 9am-5pm EST) or e-mail ​techsupport@investintech.com​. 

 

mailto:techsupport@investintech.com

